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Documentation Updates

The title page of this document contains the following identifying information:

® Software Version number, which indicates the software version.

® Document Release Date, which changes each time the document is updated.

® Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage
your business. As a valued support customer, you can benefit by using the support web site to:

® Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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About this PDF Version of Online Help

This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple topics from the help information or read the online help in
PDF format. Because this content was originally created to be viewed as online help in a web browser, some topics may not be formatted properly. Some interactive
topics may not be present in this PDF version. Those topics can be successfully printed from within the online help.
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About this Guide

Welcome to the Customization Editor User Guide. This guide explains how to use Customization
Editor as part of Systinet.

This guide contains the following chapters:
¢ "Overview " on page 12

Provides an overview of the main features of Customization Editor.
o "Getting Started " on page 23

Describes the installation of the main features, and shows you how to create an extension
inCustomization Editor.

o "Manipulating Artifact Types " on page 30
Explains how to create, modify and delete artifacts and packages using Customization Editor.
e "Creating and Using Components " on page 40
Shows how to create and use custom components in Customization Editor .
¢ "Modifying Taxonomies " on page 43
Shows how to build and modify taxonomies for an extension project in Customization Editor.
¢ "Deploying Extensions " on page 45
Instructions on how to deploy extensions created in Customization Editor.
e "Views " on page 51
Explanation of each view in Customization Editor.
o "Dialog Boxes " on page 68
Dialog boxes reference.
e "Localname Naming Rules " on page 87

Naming strategies for database tables and columns.
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Chapter 1

Customization Editor

HP Systinet Customization Editor is a set of Workbench features that enable you to edit the
underlying SOA Definition Model (SDM) configuration of an installation of HP Systinet.

In HP Systinet versions 4.00 and later, Web GUI customization is performed separately from SDM
customization. After applying an SDM extension, HP Systinet administrators must configure the Ul
visibility of artifacts/properties in the web GUI using the Administration -> Customize menu. For
more details refer to the Administration Guide Ul Customization chapter.

This chapter introduces Customization Editor in the following sections:

o "Workbench Suite " below

"Overview " on the next page

e "User Interface " on the next page

"SDM Elements " on page 20

Workbench Suite

HP Systinet Workbench is a suite of editor tools enabling you to customize your deployment of HP
Systinet 4.0 and later.

Workbench consists of the following editor tools, distributed as a single Eclipse development
platform:

o Customization Editor
Customizes the underlying SOA Definition Model (SDM) within HP Systinet.
o Taxonomy Editor
Customizes the taxonomies used to categorize artifacts in HP Systinet.
o Assertion Editor
Customizes the conditions applied by your business policies within HP Systinet.
o Report Editor

Customizes report definitions for use with HP Systinet.
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Overview

HP Systinet is distributed with a preconfigured data model. For typical deployment scenarios, the
model should be customized to fit an organization-specific environment.

HP Systinet Customization Editor provides a mechanism to customize the model, implement those
changes, and keep them isolated in a so-called extension package that can then be re-applied
during a re-installation or upgrade of HP Systinet.

To customize HP Systinet, follow this process:

1.

Create an extension project.

For details, see "Creating an Extension Project " on page 26.

Modify the data model.

For details, see the following:

» "Manipulating Artifact Types " on page 30

» "Modifying the Properties of an Artifact Type " on page 31

n "Creating and Using Components " on page 40

» "Modifying Taxonomies " on page 43

Deploy the customization to HP Systinet.

For details, see Deploying Extensions.

Be very careful when modifying artifacts that already have instances in the repository. For
example, a new installation already contains the person artifact administrator. Removing
properties from an artifact type with instances, or adding a new required property without a

default value, may cause instability in HP Systinet. Customization Editor should prevent this if
the HP Systinet server is running during modification.

User Interface

The default Extension perspective is split into a number of sections with menu options across the
top, as shown in “Customization Editor UI”.

Customization Editor Ul
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The perspective consists of the following elements:
o Project Explorer
The tree view of the SDM configuration represented by your project.

For details, see "Extension Explorer " on the next page.

o Server Explorer
The view listing HP Systinet server connections to Workbench.
For details see, "Server Explorer " on page 19.

o Editor Views
The main area of the perspective contains editor views of project elements. You can open
multiple editors. The functionality of each editor varies depending on the project element.
For details, see "Views " on page 51.

¢ Information Views

Messages and search results open their own views.

For details, see "Views " on page 51.
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¢ Menu Items
The standard Eclipse menu options plus additional Workbench options.

For details about the additional options for Customization Editor, see "Menu Options " on page
18.

Extension Explorer

The Extension Explorer, as shown in“Extension Explorer View”, represents a tree view of the
extension project that you are currently working with. It includes all the elements from extensions
that it depends on as well.

Extension Explorer View
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The tree is split into the extension root and five branches representing different elements of your
extension.

Double-click an item in the tree to open the relevant editor, ot to open or close a branch.
For details about each editor, see "Views " on page 51.

Right-click an element to open a context menu that contains options for the element.
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Each element and its contextual functionality is described in the following sections:
o "Extension Name " below

o "Artifact Types " below

o "SDM Details " on the next page

o "User Interface " on page 12

o "Taxonomies " on page 22

¢ "project.xml Editor " on page 57

Extension Name

The extension name is the root element of the project.

The context menu contains the option to Build Extension, which creates a jar file that contains
your extension. This extension is ready to import to HP Systinet.

For deployment details, see "Deploying Extensions " on page 45.

Artifact Types

The Artifact Types branch contains the artifact types organized into a hierarchical structure
reflecting the SOA Definition Model (SDM). Each element within Artifact Types is a type of artifact
or artifact package.

Caution: Systinet separates the SDM into two models, public and system. Customization Editor
hides system artifacts, preventing you from modifying them.

Tip: An artifact package is an artifact type that serves as a group of other artifacts. They do not
have instances in the repository and just serve to organize a hierarchy of artifact types in the SDM.

For details, see "Artifacts " on page 20.

The context menu for the Artifact Types branch contains the following functionality:

o New Artifact Type or Package
Creates an artifact type as described in "Creating an Artifact Type or Package " on page 30.

o Open Artifact Type or Package
Opens the artifact editor for the selected element with the name of the element as the editor title.
For details, see "Artifact Editor " on page 51.

o Deprecate Artifact Type or Package
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Deactivates the artifact type in the extension project and hides it in the HP Systinet Ul.
o Undeprecate Artifact Type or Package

Reactivates a deprecated artifact type in the extension project.
o Delete Artifact Type or Package

Removes the artifact type from the extension project.

SDM Details

The SDM Details branch contains two element types described in the following sections:

o "Property Descriptors " below

o "Property Groups " on page 21

HP Systinet separates the SDM into two models, public and system. The Customization Editor

shows properties and property groups used by system artifacts, but prevents you from modifying
them.

Property Descriptors

Property descriptors are the attributes of artifact types.
For details, see "Properties " on page 20.

In the Extension Explorer, properties are divided into the following branches:
o Primitive Property Descriptors

¢ Relationship Property Descriptors

e Taxonomy Property Descriptors

Each property type branch contains one context menu option: New Property.
For details, see "Creating a Property " on page 37.

Each property type branch contains a list of the properties of that type.

The context menu for properties contains the following options:

e Open Property

Opens the property editor for the selected element with the name of the element as the editor
title.
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For details, see “Property Editor”.
o Deprecate Property
Deactivates the property in the extension project and hides it in the HP Systinet user interface .
o Undeprecate Property
Reactivates the deprecated property in the extension project.
o Delete Property
Removes the property from the extension project.
o Find Usage
Opens a search view displaying all the artifacts and property groups containing this property.

For details, see "Search View " on page 65.

Property Groups

Property groups are sets of properties that can be added collectively to an artifact type.
For details, see "Property Groups " on page 21.

The context menu of the Property Group branch contains one option: New Property Group.
For details, see "Creating a Property Group " on page 38.

The context menu for each property group contains the following options:
e Open Property Group

Opens the property group editor for the selected element with the name of the element as the
editor title.

For details, see "Property Group Editor " on page 64.
o Delete Property Group
Removes the property group from the extension project.
o Find Usage
Opens a search view displaying all the artifacts that contain this property group.

For details, see "Search View " on page 65.
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Menu Options

The menus in Workbench are standard Eclipse menus, with the addition of specific functionality for
Workbench editors.

The additional menu options for Customization Editor include:
o File>New>HP Extension Project

Create a new project, as described in "Creating an Extension Project " on page 26.
o File>New>Artifact Type

Create an artifact type, as described in "Creating an Artifact Type or Package " on page 30.
o File>New>Artifact Package

Create an artifact package, as described in "Creating an Artifact Type or Package " on page 30.
o File>New>Property

Create a property, as described in "Creating a Property " on page 37.
o File>New>Property Group

Create a property group, as described in "Creating a Property Group " on page 38.
o File>New>Component

Create a component, as described in "Creating a Component " on page 40.
o File>New>Task

Create atask, as described in "Creating a Task " on page 41.
o Navigate>Go To>Open Artifact

Open an artifact editor, as described in "Artifact Editor " on page 51.

The keyboard shortcut Ctrl+Alt+A also performs this function.
+ Navigate>Go To>Open Property

Open a property editor, as described in "Property Editor " on page 61.

The keyboard shortcut Ctrl+Alt+P also performs this function.

+ Navigate>Go To>Open Property Group
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Open a property group editor, as described in "Property Group Editor " on page 64.

The keyboard shortcut CtrlI+Alt+R also performs this function.
¢ Search>Search

Open a search dialog box, as described in "Searching the Extension Project" on page 29.
o Help>Dynamic Help

Access context-sensitive help, directing you to the relevant section of this document based on
the active view in Customization Editor.

Server Explorer

The Server Explorer displays the HP Systinet servers connected to Workbench, as shown in
“Server Explorer View”. The functionality is shared by all the Workbench editors.

Server Explorer View

¥ Server Explorer &3 0= Dutline ¥ =0

CMIHP SOA Systinet Server gals
(4 Mew Server

iy

[~ Remove Server

%5 Download Taxonomy
FEy Download Assertion
(g Download Report

Properties

Right-click a server in the Server Explorer to open the context menu described in “Server Explorer
Context Menu Options”.

Server Explorer Context Menu Options

Option Function

New Server  Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

Remove Delete a server from the Server Explorer.
Server
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Option Function

Download Download a taxonomy from a platform server (Taxonomy Editor and
Taxonomy Customization Editor).

Download Download assertions from a platform server (Assertion Editor).
Assertion

Download Download reports from a reporting server (Report Editor).

Report

Properties View and edit the server name, URL, username, and password.

SDM Elements

Customization Editor manages four types of entities in the SDM configuration of HP Systinet.

These entity types are described in the following sections:

"Artifacts " below

"Properties " below

"Property Groups " on the facing page

"Taxonomies " on page 22

Artifacts

Artifacts are the basic building blocks of SOA. Every entity in the repository is an instance of an
artifact. Each type of artifact is defined by an artifact type in the SDM. Artifact types are further
categorized into artifact packages. These packages are abstract artifact types that do not have
instances in the repository but instead define groups of artifacts.

You can explore artifact types and packages in the Artifact Types branch of the Extension Explorer.
For details, see “Artifact Types”.

For artifact type procedures, see "Manipulating Artifact Types " on page 30.

Properties

Properties are the attributes of artifacts, the labels that distinguish one instance of an artifact from
another. For example, all artifact instances have the name property, but every artifact has a different
name.

There are three categories of property:

o Primitive Properties

Page 20 of 87 HP Systinet Workbench (10.00)



Customization Editor User Guide
Chapter 1: Customization Editor

The basic labels for artifacts such as name and description.

Basic properties are of the following types:

Property Type
addressProperty Type
booleanProperty Type
categoryBagProperty Type

dailyIntervalProperty Type

dateTimeProperty Type
doubleProperty Type
encryptedPasswordProperty Type
identifierBagProperty Type
integerProperty Type
nameUrlPairProperty Type
nameValuePairProperty Type
plainTextProperty Type

textareaProperty Type

o Relationship Properties

Description

A full postal address.

True orfalse.

A taxonomic categorization.

A time period with a start and end day, for example
Monday to Friday.

A specific date and time.

A double precision floating point number.

An encrypted password.

A taxonomic identification.

An integer number.

A URL with an optional name assigned.

A name and value pair.

One-line text, suitable for properties such as name.

Multi-line text, suitable for properties such as description.

The nature and direction of a relationship with another artifact such as ImplementationOf.

o Taxonomy Properties

The categories used to define an artifact based on taxonomies such as the High category in the

Failure Impact taxonomy.

You can explore properties in the SDM Details branch of the Extension Explorer.
For details, see “SDM Details”.

For property procedures, see "Modifying the Properties of an Artifact Type " on page 31.

Property Groups

You can organize properties into groups, and add them to artifacts collectively instead of
individually. For example, you can organize name, address, and telephone number into a contact
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details property group. Then, whenever a new artifact type is created that represents a person, the
group can be added to it instead of the individual properties.

You can explore property groups in the SDM Details branch of the Extension Explorer.
For details, see “SDM Details”.

For property group procedures, see "Modifying the Properties of an Artifact Type " on page 31.

Taxonomies

Taxonomies are categorization groups, each of which contain a set of values within a single
category. For example, office location can be a taxonomic group containing a set of values
representing each office in an organization.

You can explore taxonomies in the Taxonomies branch of the Extension Explorer.
For details, see “Taxonomies”.

For taxonomy procedures, see “Modifying Taxonomies " on page 43.
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Chapter 2
Getting Started

You can use Customization Editor to create extensions to the core HP Systinet configuration. The
core configuration itself is not modified. Instead, HP Systinet includes a utility for adding
extensions to the configuration.

This chapter contains the following sections:

o "Installing Workbench" below

o "SSL Configuration" on page 25

o "Creating an Extension Project " on page 26
e "Searching the Extension Project" on page 29

¢ "Saving Modifications " on page 28

Installing Workbench

Systinet Workbench is an Eclipse development platform distributed as a zip file, hp-systinet-
workbench-10.00-win64.zip .

Note: For supported platforms and known issues, see readme. txt alongside the archive.

Note: Systinet Workbench requires Java SE Development Kit (JDK) 1.7.0 (64-bit version only)

or higher. You must include the path to this version of the JDK in the JAVA_HOME environment
variable.

To install Systinet Workbench as a new Eclipse platform:

o Extract the archive to your required location, referred to in this document as WB_HOME.
Note: The path must not be longer than 97 characters.

To Start Systinet Workbench:

o Execute WB_HOME/workbench/start.exe.

The first time you start Workbench, the welcome screen opens.
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Screenshot: Workbench Welcome Screen

Develop Assertion Develop Taxonomy

Create Assertion Project Create Taxonomy Project
Go to Platform Perspective Go to Platform Perspective
Help Help

Design Report Customize SOA Model

Create Report Project Create Extension Project
Go to Platform Perspective Go to Extension Perspective
Help Help

Select one of the options to open one of the editor tools, start a new editing project, or view the
documentation set.

You can return to the welcome screen from any of the editor tools by selecting Help>Welcome
from the menu options.

By default, Workbench runs in 'normal' mode which prevents users from uploading system
taxonomies (IDs start with uddi:systinet.com:soa:model:taxonomies)and the Report Editor

.rptlibrary file to Systinet servers. If you need to work with system taxonomies or want to
upload the . rptlibrary file you can switch Workbench into 'admin' mode.

Caution: Be extremely careful when working with system taxonomies, Systinet uses some
hard-coded values from system taxonomies, changing or removing them may cause errors.

To Switch Workbench to Admin Mode
1. Open WB_HOME/configuration/config.ini with atext editor.
2. Add mode=adminto config.ini.

3. Restart Workbench.

Tip: Systinet Workbench is memory-intensive. If you experience performance issues, HP
recommends increasing the memory allocation.

To increase the memory allocation for Systinet Workbench:
1. Open WB_HOME/workbench/start.ini for editing.

2. Set these new values:
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= -Xms128m
= -Xmx1024m
3. Save your changes.

4. Restart Workbench.

Tip: Systinet Workbench downloads from Systinet may time out. If you experience issues, HP
recommends increasing the time out.

To increase the time out for Systinet Workbench:

1. Open WB_HOME/workbench/start.ini (oreclipse.ini for stand-alone installation) for
editing.

2. Set the new value:
-Dorg.systinet.platform.rest.Client.timeout=200000
The value is in milliseconds with a default value of 120000 (2 minutes).
3. Saveyour changes.

4. Restart Workbench.

SSL Configuration

By default, Workbench trusts all Systinet server certificates. You may want Workbench to verify
Systinet certificates.

To Verify Systinet Server Certificates:

¢ Add the following options to WB_HOME /workbench/start.ini:

-Dcom.hp.systinet.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If Systinet is configured for 2-way SSL, you must provide Workbench certificates to Systinet.

To Provide Workbench Client Certificates to Systinet:

¢ Add the following options to WB_HOME /workbench/start.ini:

-Djavax.net.ssl.keyStore=USER_KEYSTORE
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-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Creating an Extension Project

The first step in customizing your HP Systinet installation is to create an extension project in the
Customization Editor. This is the workspace where you make all your modifications.

HP Systinet supports the separation of projects based on their type. The following extension project
types are supported:

e model

Extensions for changes to the data model.
e code

Extensions for custom components.
e mixed

Combined model and code extensions.

HP Software recommends separating extensions into separate types because HP Systinet does
not guarantee backward compatibility for the Java API. This may make it difficult to migrate custom
components to newer versions.

model extensions are easily migrated by opening them in the latest version of Customization
Editor, building a new extension and redeploying them.

To create an extension project:
1. Inthe menu, select File>New>Project.
The New Project wizard opens.
2. Expand HP Systinet Extension Project, and click Next.
3. Inthe New Extension Project dialog box, add the parameters you want.

For parameter descriptions, see "New Extension Project: Specify HP Systinet Server
Installation " on page 72.

4. Click Next to select or create a server.
If no servers are currently configured the dialog continues to Step 6.
5. Do one of the following:

s Select Create a New Server, and then click Next.
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Continue to Step 6.

= Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.

Continue to Step 7.
6. Inthe New Server dialog box, add the parameters you want, and then click Next.
For parameter descriptions, see "New Extension Project: New Server " on page 73.
7. Do one of the following:

= Select Create a New Extension Project from Scratch to create an empty extension
containing no elements at all.

Click Next.
= Select Edit an Existing Extension to open an existing extension for modification.

Select an extension from the extension folder, or use Add Extension to select one from
another location.

Click Next to continue to Step 10.

= Select Create a New Extension from an Existing One to use an existing extension as
the basis of a new one.

Select an extension from the extension folder or use Add Extension to select one from
another location.

Click Next.

If you use this option, you must remove the existing extension from the extensions folder
before you deploy the new modified extension.

8. Inthe Create Extension or Project dialog box, add the parameters you want, and then click
Next.

For parameter descriptions, see "New Project: Create a New Extension " on page 75.

9. Inthe Add Dependencies dialog box, optionally select or add extensions to depend on, and
then click Next.

10. Inthe HP Systinet Extension Project dialog box, add the parameters you want, and then select
available projects to reference.

Adding referenced projects enables you to use assertions or taxonomies from the referenced
projects without the need to copy them manually to the extension project.

11. Click Finish to open the project.
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In the Platform perspective, the Project Explorer now displays a view of your extension that
contains not only the elements contained in your extension project but all the elements from any
other extensions that your project depends on.

For details about the contents of your extension project, see "Extension Explorer " on page 14.

Sharing an Extension Project

HP Systinet enables the sharing of an extension project in the CVS repository.

To share an extension project:

1. In Extension Explorer, right-click the project you need to open its context menu, and select
Team>Share Project to open the Share Project dialog box. For details, see "Share Project "
on page 85.

2. Enterthe required parameters and click Finish.

The project is published to the CVS repository.

Referencing Other Workbench Projects

You caninclude assertions and taxonomies from an Assertion or Taxonomy Project in your current
Extension Project.

To reference an Assertion or Taxonomy Project:

1. From the platform perspective, right-click your extension project and select Properties to open
the Preferences dialog box, and then select Project References to view projects available to
reference.

2. Select the projects you want to reference and click OK.

The assertions or taxonomies from the referenced project are copied to your extension project.

Saving Modifications

As you modify an entity in your extension project, the tab label of the entity editor is marked with an
asterisk (*).

To save your changes to the project, select File>Save from the menu, or use keyboard shortcut
Ctrl+S.

If you close an editor or the application with unsaved changes, you are prompted to save these
changes.

Your modifications are made to your extension project and not to the configuration of HP Systinet.
To deploy your customization to HP Systinet, see "Deploying Extensions " on page 45.
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Searching the Extension Project

The Customization Editor contains a customized search function, which enables you to find entities
in your extension project.

To search your extension project:
1. From the menu, select Search>Search.
The Search dialog box opens.
2. Inthe SDM Search tab of the Search dialog box, add the parameters for your search.
For parameter descriptions, see "Search " on page 84.
3. Click Search.
The search results appear in the Search view.

For details, see "Search View " on page 65.
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You can use Customization Editor to create, modify, and delete artifact types and packages in your
extension project. You can also change the format of artifact pages in the HP Systinet UI.

HP Systinet separates the SDM into two models, public and system. Customization Editor hides
system artifacts, preventing you from modifying them.

For more details about artifact types and packages, see "Artifacts " on page 20.

The chapter explains the following procedures:

"Creating an Artifact Type or Package " below

+ "Modifying the Attributes of an Artifact Type " on the next page
« "Modifying the Properties of an Artifact Type " on the next page
o "Mapping an Artifact Type to a Registry " on page 33

o "Example: Adding the Department Property to Services " on page 35

Creating an Artifact Type or Package

Customization Editor enables you to create a new artifact type or package in your extension
project.

To create an artifact type or package:
1. Do one of the following:
= From the main menu, select New>Artifact Type or Package.

= Inthe Extension Explorer, open the context menu of an artifact package branch and select
New Artifact Type or Package.

The New Artifact Type or New Artifact Package dialog box opens.
2. Inthe dialog box, add the artifact parameters you want.

For parameter descriptions, see "New Artifact: Create " on page 68.

For localname naming conventions, see "Localname Naming Rules " on page 87.
3. Do one of the following:

= Click Finish to create the artifact type or package and exit the dialog box.
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= Click Next and continue to Step 4 to set database parameters.
4. Inthe dialog box, add the database parameters you want.
For parameter descriptions, see "New Artifact: Database Settings " on page 70.

5. Click Finish to create the artifact type or package.

Modifying the Attributes of an Artifact Type

Customization Editor enables you to edit the main attributes of artifact types.

To edit the attributes of an artifact type:
1. Open the artifact editor and select the Overview tab.
2. Inthe Overview tab, make any changes you want.
You cannot change the local name of the artifact if the extension project is in production mode.
For a description of the Overview tab, see "Artifact Editor: Overview Tab " on page 52.

3. Press Ctrl+S to save your changes.

Modifying the Properties of an Artifact Type

The main attributes of artifact types are properties. You can modify these properties, add them
individually, or add them as a group within the artifact editor.

To add or modify the properties and property groups of an artifact type:
1. Open the artifact editor and select the Properties tab.
2. Inthe Properties tab, make any changes you want.
For a description of the Properties tab, see "Artifact Editor: Properties Tab " on page 53.
3. Press Ctrl+S to save your changes.

You can change the local name of the property descriptor defined in the current extension project.

To change the local name of a property descriptor:
1. From the tree menu of Extension Explorer, expand SDM Details>Property Descriptors.
2. Browse for the descriptor you want, and double-click to open the Overview view.
3. Inthe Local Name field, enter the parameters you require, and then save your changes.

You can also change the cardinality of an artifact defined in the current extension project.
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You cannot change the local name of the property descriptor if the extension project is in production
mode.

To change the cardinality of an artifact type:

1. Browse for the artifact you need and open the Editor view, and then switch to the Properties
tab.

2. Inthe Cardinality field, click to open the drop-down menu, and select the cardinality you need.

For taxonomic properties, the cardinality affects the way the property displays in the HP
Systinet Ul.

= Required taxonomic properties display as an Add Category function.

= Optional taxonomic properties display as a drop-down menu.

= Multiple taxonomic properties display as a list box.

You cannot change the cardinality of an artifact if the extension project is in production mode.

You can also change the direction of relationship of a property descriptor which is defined in the
current extension project.

o change the direction of a relationship property descriptor:

1. In Extension Explorer, expand SDM Details>Property Descriptors>Relationship Property
Descriptors and double-click the descriptor you need to open its Editor view.

2. Inthe Direction field, click the link next to Inverse Display Name to toggle the relationship
between incoming or outgoing, and then save your changes.

Systinet also enables you to modify the taxonomical properties of an artifact type.

To modify the taxonomical properties of an artifact:

1. In Extension Explorer, browse for the artifact you need and open its Editor view, and then
switch to the Properties tab.

2. Inthe Properties window, click New to open the New Property dialog box, and select
Taxonomy Property, and then click Next.

The New Taxonomy Property dialog box opens. For details, see "New Property: Taxonomy "
on page 79.

3. Enter general parameters and in the Taxonomy Name field, do one of the following:
= Click Browse to browse for and select from a list of available taxonomies.

= Click Create to open the Create a New Taxonomy dialog box,. For details, see "New
Taxonomy " on page 82.
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4. Enterthe parameters you want and click Finish.
The created taxonomy is now visible in the New Taxonomy Property dialog box.

5. Click Finish.

Mapping an Artifact Type to a Registry

You can map artifacts in HP Systinet to registry entities in a UDDI registry.

The artifact types listed in “Predefined Registry Mapping” have predefined mappings to registry and
cannot be amended.

Predefined Registry Mapping

SDM Artifact UDDI Entity Direction
Organizational Unit BusinessEntity Bi-directional
Business Service tModel Bi-directional

Implementation Artifacts = Business Service | Bi-directional

Endpoint BindingTemplate = Bi-directional

The mapping of an artifact to a registry entity is illustrated in “Registry Mapping”.
Registry Mapping
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Systinet2 UDDI Registry

«» Heyed Reference

KeyName and KeyValug set in
Customization Editor

I > Keyed Reference
KeyName set in Customization Editar
KeyWalue taken from property value

Property 1 in Systinet2

I > Keyed Reference
KeyName set in Customization Editar
KeyWalue taken from property value

Property 2 in Systinet2

Artifac tModel

To add or modify artifact type mappings to registry entities:
1. Open the artifact editor and select the Registry Mapping tab.
2. Inthe Registry Mapping tab, make any changes you want.

For a description of the Registry Mapping tab, see "Artifact Editor: Registry Mapping Tab " on
page 55.

For details on how to add an artifact mapping, see "Adding a Registry Mapping for an Artifact
Type " below.

For details on how to add a property mapping, see "Adding a Registry Mapping for a Property "
on the next page.

3. Press Ctrl+S to save your changes.

Adding a Registry Mapping for an Artifact Type

You can map artifact types to registry entities.

To add an artifact mapping:
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1. Open the Artifact Editor and select the Registry Mapping tab.
2. Inthe Artifact Mapping pane, click Add.
The New Artifact Mapping dialog box opens.
3. Inthe New Artifact Mapping dialog box, add the parameters you want.
For parameter descriptions, see "Registry Mapping: New Artifact Mapping " on page 82.

4. Click Finish to add the mapping.

Adding a Registry Mapping for a Property

You can map properties to registry entity keyed references.

To add a property mapping:
1. Open the Artifact Editor and select the Registry Mapping tab.
2. Inthe Property Mapping pane, click Add.
The New Property Mapping dialog box opens.
3. Inthe New Property Mapping dialog box, add the parameters you want.
For parameter descriptions, see "Registry Mapping: New Property Mapping " on page 83.

4. Click Finish to add the mapping.

Example: Adding the Department Property to
Services

In this example, you add a new taxonomic property, department, to the service artifact.

To follow this example, you must first do the following:

o In Customization Editor, create a new extension dependent on the core extension, as described
in "Creating an Extension Project " on page 26.

o In Taxonomy Editor, create a new department taxonomy and deploy it to HP Systinet, as
described in the "Example: Creating and Publishing a Department Taxonomy" section of the HP
Systinet Taxonomy Editor Guide.

To add the department property to services:
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. Open theService editor and select the Properties tab.

In the Properties segment, click New.

Select Taxonomy Property and click Next.

Input Department as the Display Name.

For the Taxonomy, click Browse and import the Departments taxonomy.
Press Ctrl+S to save your changes to the business service artifact type.
Deploy your extension, as described in "Deploying Extensions " on page 45.

Start your installation of HP Systinet.

Add the property to the artifact in the user interface. For details, see "Ul Customization" in the HP
Systinet Administration Guide.
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Customization Editor enables you to create, modify, and delete properties and property groups in
your extension project.

HP Systinet separates the SDM into two models, public and system. Customization Editor shows
properties and property groups used by system artifacts, but prevents you from modifying them.

For more details about properties and property groups, see "Properties " on page 20 and "Property
Groups " on page 21.

This chapter describes the following procedures:

"Creating a Property " below

"Modifying a Property " on the next page

"Creating a Property Group " on the next page

"Modifying a Property Group " on page 39

In addition, "Manipulating Artifact Types " on page 30 includes the following procedures related to
properties:

« "Modifying the Properties of an Artifact Type " on page 31

o "Mapping an Artifact Type to a Registry " on page 33

Creating a Property

You can create properties individually and then add them to artifact types later.

To create a property:
1. Do one of the following:
= From the menu, select File>New>Property.

= Inthe Extension Explorer, open the context menu for the Property Descriptors branch,
select New Property, and then select the property type.

= Inthe Extension Explorer, open the context menu for a property type branch and select New
Type Property to create a property of that type.

The New Property dialog box opens.

2. Inthe New Property dialog box, add the property parameters you want.
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For parameter descriptions of each property type, see the following:

= "New Property: Primitive " on page 77

= "New Property: Relationship " on page 77

= "New Property: Taxonomy " on page 79

For localname naming conventions, see "Localname Naming Rules " on page 87.

3. Click Finish to create the property.

Modifying a Property
Customization Editor enables you to modify properties.
To edit a property:
1. Open the Property Editor.
2. Inthe Property Editor, make any changes you want.
For a description of the Property Editor, see "Property Editor" on page 61.

3. Press Ctrl+S to save your changes.

Creating a Property Group

Many artifact types share sets of the same properties. It is useful to create groups of properties and
add these to artifact types instead of adding each property individually.

To create a property group:
1. Do one of the following:
= From the menu, select File>New>Property Group.

= Inthe Extension Explorer, open the context menu for the Property Groups branch, and
select New Property Group.

= Open the Artifact Editor and select the Properties tab. In the Property Groups pane, click
New to create a new property group as a set of attributes for an artifact type.

The New Property Group dialog box opens.

2. Inthe New Property Group dialog box, add the parameters you want.
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For parameter descriptions, see "New Property Group " on page 80.

3. Click Finish to create the property group.

Modifying a Property Group

Customization Editor enables you to modify property groups.

To edit a property group:
1. Open the property group editor.
2. Inthe Property Group Editor, make any changes you want.

For a description of the Property Group Editor, see "Property Group Editor " on page 64.

3. Press Ctrl+S to save your changes.
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Creating and Using Components

The Customization Editor enables you to create custom components, for use in the customizable
HP Systinet user interface.

To create and use components:

1. Create a new extension project, selecting Develop JSPs, and setting the appropriate
application server settings.

For details, see as described in “Creating an Extension Project”.
2. Create a component.
For details, see “Creating a Component”.
3. Create atask to use your component.
For details, see “Creating a Task”.
4. Develop the Java and JSP that the component uses.
For details, see “Developing a Component”.
5. Deploy the code extension to HP Systinet.
For details, see "Deploying Extensions " on page 45.
6. Perform the appropriate Ul customization to use your component in HP Systinet.

For details, see "Ul Customization" in the HP Systinet Administration Guide.

Creating a Component

Components are functional elements that you can call using a number of different elements in the
HP Systinet user interface.

To create a component:
1. Do one of the following:

= Inthe Extension Explorer, open the context menu for the Components branch and select
New Component.

= Inthe Components Editor, click Add.
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The New Component dialog box opens.
2. Inthe New Component dialog box, add the parameters you want.
For parameter definitions, see “New Component”.

3. Click Finish to create the component.

Creating a Task

Tasks are top level components accessible via their URIs. The addition of a URI allows you to
access the component in the HP Systinet user interface, and to make more sophisticated multi-
layered components.

To create a task:
1. Do one of the following:

= Inthe Extension Explorer, open the context menu for the Tasks branch and select New
Task.

= Inthe Tasks editor, click Add.
The New Task dialog box opens.

2. Inthe New Task dialog box, add the parameters you want.
For parameter descriptions, see “New Task”.

3. Click Finish to create the task.

Developing a Component

When you create a component, as described in "Creating a Component " on the previous page, the
templates for the Java class and JSP page are created automatically.

To view this code, switch to the Java or Debug perspective, as shown in “Debug Perspective”.

Debug Perspective
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The project contains two source folders containing the Java and JSP files, respectively.

To open an edit view, double-click the source file you want to edit. In the edit view, you can write a
custom component.
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Customization Editor controls which taxonomies are available in the extension project. You can
create and modify taxonomies from your extension project.

Creating and modifying taxonomies uses the Taxonomy Editor functionality.
For details, see the HP Systinet Taxonomy Editor Guide.

To control taxonomies in your extension project:
1. Inthe Extension Explorer, double-click the Taxonomies branch to open the Taxonomies editor.
2. To maodify the available taxonomies in your extension project, do one of the following:
= Open the taxonomy from the extension project, and edit the parameters as required.
The modified taxonomy is then indicated by a > next to the taxonomy.

= Toimport taxonomies from HP Systinet and add them to the extension, click Import. Select
multiple taxonomies by holding Ctrl.

You can also import taxonomies in the Server Explorer view. For more details, see "Server
Explorer " on page 19.

= To update taxonomies in your extension to newer versions from HP Systinet, click Update.
Select multiple taxonomies by holding Ctrl.

Alternatively, in the Extension Explorer, expand the branches in the Taxonomy branch,
select the taxonomy (use Ctrl to select multiple taxonomies), open the context menu, and
select Update Taxonomy.

The selected taxonomies are added as separate items for modification under the Taxonomy
branch.

= Toremove a taxonomy from the extension, select the taxonomy and click Remove. Select
multiple taxonomies by holding Ctrl.

To enable the import or update of taxonomies from HP Systinet, you must specify the
correct server URL during configuration.

For details, see "Creating an Extension Project " on page 26.

You can change the taxonomy in a taxonomy based property descriptor which is used in the current
extension project.

To change the taxonomy in a taxonomy based property descriptor:
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1. Inthe tree menu of Extension Explorer, expand SDM Details>Taxonomy Property
Descriptors and double-click the descriptor you need to open its Editor in the Overview tab.

2. Inthe Taxonomy Name field, click Browse.
3. Select the taxonomy you want, and click Select.
The new taxonomy overrides the previous taxonomy in the property descriptor.

You cannot change the taxonomy in a taxonomy based property descriptor if the extension
project is in production mode.
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Deploying Extensions

Deploying an extension to HP Systinet is a three-part process:
1. "Exporting the Extension Project " below

2. "Applying Extensions " below

3. "Redeploying the EAR File " on page 49

Alternatively, if you are developing components in Customization Editor, you can directly deploy an
extension from Customization Editor.

For details, see "Deploying Components to HP Systinet " on page 50.

Exporting the Extension Project

Customization Editor displays the entire configuration of your extension plus other extensions it
depends on. However, your extension consists only of any modifications and additions that you
have made. Only these changes are stored when you save your project as an extension JAR file,
and only these changes are deployed to HP Systinet.

To create your extension package:

1. Inthe Extension Explorer, open the context menu of the extension name, and select Build
Extension.

The Export Extension dialog box opens.
2. Choose a save location and file name, and then click Save.
By default, the Extension Folder set during configuration is selected.
For configuration details, see "Creating an Extension Project " on page 26

If the extension already exists, Customization Editor prompts you to confirm that you want to
overwrite it.

Applying Extensions

You can extend HP Systinet by adding libraries or JSPs to the deployed EAR files, by modifying
the data model, by configuring the appearance of the Ul, and by importing prepackaged data.

Extensions to HP Systinet come from the following sources:
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o Customization Editor

Typical extensions created by Customization Editor contain modifications to the data model and
artifact appearance, and possibly data required by the customization (taxonomies). They may
also contain new web components, which may include custom JSP and Java code.

If your extension contains new artifact types, HP Systinet does not create default ACLs for
them. Set default ACLs for the new artifact types in HP Systinet using the functionality
described in "How to Manage Default Access Rights" in the Administration Guide.

o Assertion Editor, Report Editor, and Taxonomy Editor

These extensions contain assertion, reporting, and taxonomy data only. They do not involve
changes to the data model.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.

Apply extensions according to one of the following scenarios:
¢ "Single-Step Scenario " on page 48

The Setup Tool performs all the processes involved in applying extensions, including any
database alterations, as a single step.

o "Decoupled DB Scenario " on the facing page

Database SQL scripts are run manually. The Setup Tool performs the other processes as
individual steps that are executable on demand. This scenario is useful in organizations where
the user applying extensions does not have the right to alter the database, which is done by a
database administrator.

The errorin setup. log resembles the following:

[java] --- Nested Exception ---

[java] java.lang.RuntimeException: cannot reduce length of identifier
'ry_c_es_Artifact@2s_c_priEspPty@l1Group_c_priEspPtyol"',
rename identifier elements or improve the squeezing algorithm

[java] at com.systinet.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniqueLimitedLengthName(BlizzardNameProviderImpl. j

ava:432

[java] at com.systinet.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.filterTableName(BlizzardNameProviderImpl.java:374)

This is due to HP Systinet using an older table naming algorithm in order to preserve backward
compatibility with HP SOA Systinet 3.00 and older versions.

If you do not require backwards compatibility with these older versions, you can change the table
naming algorithm.

To change the table naming algorithm:
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Open SYSTINET _HOME/1lib/pl-repository-old.jar#META-INF/rdbPlatformContext.xml
with a text editor.

In the rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>

Save rdbPlatformContext.xml

This solution only impacts properties with multiple cardinality. If the problem persists or you need to
preserve backwards compatibility, then review the property naming conventions in your extension.

Note: In some specific circumstances (underscores and numbers in property names), extension
application may fail because Systinet cannot create short enough database table names (31
character maximum for most databases).

Decoupled DB Scenario

Follow this scenario if the user who applies extensions does not have permission to modify the
database.

To apply extensions and modify the database separately:

1.

Make sure that all extensions are in the following directory:
SYSTINET_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.

Stop the server.

Start the Setup Tool by executing the following command:
SYSTINET_HOME!/bin/setup -a.

Select the Apply Extensions scenario, and click Next.

Click Next, to execute the extension application, and exit the Setup Tool.
Provide the scripts from SYSTINET_HOME/sql to the database administrator.

The database administrator can use all.sql to execute the scripts that drop and recreate the
database schema.

Execute the Setup Tool in command-line mode to finish the extension application:
SYSTINET_HOME/bin/setup -c
Redeploy the EAR file:

= JBoss

HP Systinet Workbench (10.00) Page 47 of 87



Customization Editor User Guide
Chapter 7: Deploying Extensions

The Setup Tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File " on
the facing page.

= Other Application Servers
You must deploy the EAR file manually.

For application server-specific details, see "Deploying the EAR File" in the HP Systinet
Installation and Deployment Guide.

Single-Step Scenario

Follow this scenario if you have permission to alter the database used for HP Systinet.

To apply extensions to HP Systinet in a single step:
1. Make sure that all extensions are in the following directory:
SYSTINET_HOME/extensions
The Setup Tool automatically applies all extensions in that directory.

If you are applying extensions to another server, substitute the relevant home directory for
SOA_HOME

2. Stopthe server.

3. Start the Setup Tool by executing the following command:
SYSTINET_HOME!/bin/setup.bat(sh)

4. Select the Apply Extensions scenario, and click Next.

The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, and merging the SDM configuration.

5. Click Next for each of the validation steps and the setup execution.
This process takes some time.

6. Click Finish to end the process.

7. Deploy the EAR file:
= JBoss

The Setup Tool deploys the EAR file automatically.
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If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File "
below.

= Other Application Servers
You must deploy the EAR file manually.

For application server-specific details, see "Deploying the EAR File" in the HP Systinet
Installation and Deployment Guide.

Restart the server.
Applying an extension that modifies the SDM model may drop your full text indices.
SYSTINET_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with slower DB
drop/create/restore scenario. ...

In these cases, reapply full text indices as described in the "Enabling Full Text Search" section
of the HP Systinet Installation and Deployment Guide.

Redeploying the EAR File

After using the Setup Tool to apply extensions or updates, you must redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.

For other application servers, follow the EAR deployment procedures described in the "Deploying
the EAR File" in the HP Systinet Installation and Deployment Guide.

Procedure 5. To redeploy the EAR file to JBoss:

1.

2.

Stop the application server.

Start the Setup Tool by executing the following command:
SYSTINET_HOME/bin/setup.bat(sh).

Select the Advanced scenario, and click Next.

Scroll down, select Deployment, and then click Next.

When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.
Click Finish to close the Setup Tool.

Restart the application server.
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Deploying Components to HP Systinet

If you are creating components in Customization Editor, it is not convenient to continually build and
apply extensions to HP Systinet. Customization Editor enables you to deploy your extension
directly to HP Systinet.

Only HP Systinet deployed to a JBoss application server is supported by this release.

To directly deploy an extension from Customization Editor:
1. Stop the application server.
2. Switch to the Debug perspective in Customization Editor.
3. From the main menu, select Run>External Tools>Open External Tools Dialog.
The External Tools dialog box opens.
4. Select Ant Build>Customization Editor — Apply Extension.
5. Click Run to apply the extension.

The Console view displays the output of the deployment process.
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Views

Each Customization Editor view in the main and bottom-right section of the editor is described in
the following sections:

o "Artifact Editor " below. Manage your SOA artifacts and customize their properties, appearance,
and registry mapping.

e "Messages View " on page 57. View the action log as you customize your extension project.
o "project.xml Editor " on page 57. Manage your extension project.

e "Property Editor " on page 61. Manage your SOA properties and which perspectives can see and
edit them.

o "Property Group Editor " on page 64. Organize your properties into groups.
e "Search View " on page 65. View the results of usage and entity searches.
o "Tasks Editor" on page 65. Manage tasks in HP Systinet.

e "Taxonomies Editor " on page 67. Customize the taxonomies available in HP Systinet.

Artifact Editor

Artifacts are the basic building blocks of SOA and represent all types of entity. This editor enables
you to modify the parameters, and properties of an artifact type within HP Systinet. Each artifact
type and package has an editor with the artifact name as the title.

Each editor contains the following tabs described in the following sections:
« "Artifact Editor " above
The main attributes of the artifact type.
o "Artifact Editor: Properties Tab " on page 53
The properties of the artifact type.
o "Artifact Editor: Registry Mapping Tab " on page 55

The mapping of the artifact to registry entities.
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Artifact Editor: Overview Tab

The Overview tab displays the general attributes of the artifact and allows you to modify some of
them.

Business Service Editor: Overview Tab
= Service &3
Overview

Artifact General Information

URI: urn:com:systinet:soa:model: artifacts:soa:businessService
Display Mame: | Service
Local Mame: | businessServiceArtifact

Collection Display Mame: | Services

Artifact Icon: ﬁ&

Package: SOA
Extends Type:

Service described in business terms that can be implemented using one of more YWeb Services or other Implementations.,
Contracts enable re-use of Services

Description:

Deprecated:
Revision Less:
Abstract:

Data attachment: none

Properties

Customize properties of this artifact by editing properties and property groups
Properties specific to artifact (11)

&Yy

Property groups specific to artifact (6
Properties inherited from superartifacts (0}

Owerview | Properties | Registry Mapping
The Overview tab contains the following segments:

o Artifact General Information. The following parameters related to artifacts shown in this pane.
They are described in the table below:

Parameter Definition
URI The identifier for the artifact descriptor in the configuration.
Display Name @ The name of the artifact as it appears in the HP Systinet Ul.

Local Name The name of the artifact as it is stored in the extension.
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Parameter Definition

Collection The plural version of the name as it appears in the HP Systinet Ul.

Display Name

Artifact Icon Displays the icon used for the artifact in the Ul with an option to change it.

Package The parent artifact type that this artifact type belongs to.

Extends Type @ The artifact type that this artifact type inherits the properties of.

Description The description of the artifact type as it appears in the HP Systinet Ul.

Deprecated A check box indicating whether the artifact is currently active in the
extension.

Revisionless Indicates whether the artifact creates a new revision when it updates.

Abstract A check box indicating whether the artifact is an artifact package which
does not have actual instances in the repository.

Data Indicates the type of data content that may be attached to the artifact.

Attachment

o Properties

A summary of the different properties that the artifact has. Each of the links opens the
Properties tab described in "Artifact Editor: Properties Tab " below.

Artifact Editor: Properties Tab

The Properties tab displays all the properties of the artifact and enables you to add and remove
them:

Business Service Editor: Properties Tab

HP Systinet Workbench (10.00) Page 53 of 87



Customization Editor User Guide

Chapter 8: Views

=» Service 7

+ Properties

Mame Cardinality
[5 service Type reqguired
[ Providing Application  multiple

[5 Provided by multiple

[ Project optional

[ Process implements  optional

[5 Part of multiple

[ Implementation multiple

[ Has impact on multiple

= rienends an mniltinla

* Property Groups

Extension

Core
Core
Core
Core
Core
Core
Core
Core

Crre

Mame Cardinality

Version Properties
= System Properties
= Service Properties
= Provider Properties
Model Properties
Consumer Properties

HEEEBB
[0 [0 (1 (P

[ [y

v Inherited Groups And Properties

Core
Core
Core
Core
Core
Core

Extension

Mame | Cardinality | Extension

Owerview |Properties | Registry Mapping

This tab contains the following panes:

o Properties

=0
£
8
Add ...
b
Add ...

| <

This is the list of individual properties of the artifact. On the right are the following buttons:

= New opens the New Property dialog described in "Creating a Property " on page 37.

= Add adds a property to the artifact type from the list of available property descriptors, set its

cardinality, and its location on the View Artifact page.
= Deprecate deactivates the property in the artifact type.

= Undeprecate reactivates the property in the artifact type.

o Property Groups

Remove removes the selected property from the artifact type.

This is the list of the property groups of the artifact. On the right are the following buttons:

= New opens the New Property Group dialog. For details, see "Creating a Property Group " on
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page 38.
= Add adds a property group to the artifact type from the list of available property groups.
= Remove removes the selected property group from the artifact type.
o Inherited Groups and Properties

If the artifact is based on another artifact then this segment displays the inherited artifact and its
properties and groups.

The following property parameters are displayed in these panes:

Parameter Definition

Name The name of the property as it appears in the HP Systinet UI.

Cardinality = The occurrence of the property in an artifact with options:
e Optional
The property is not required to be populated.
e Required
The property must be populated.

o Multiple

The cardinality is determined by the MinOccurs/MaxOccurs defined in the
Property Editor: Advanced Tab. For details, see "Property Editor: Advanced
Tab " on page 62.

Extension = Which extension this property is part of.

Artifact Editor: Registry Mapping Tab

The Registry Mapping tab displays any mappings between the artifact and entities in registries
and allows you to create, edit, and remove them:

Business Service: Registry Mapping Tab
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= *Service &7 =0

« Artifact Mapping

Registry Mame  TModel Key Key Mame  Key Value  Extension Add ..
All others uddi:systinet.com:soa:model: taxonomies: artifactTypes art mike-ce

+ Properties Mapping

Property Mame = Registry Mame = TModel Key | Key Mame  Extension Add ...

Owverview |Properties | Registry Mapping
It is split into the following panes:
o Artifact Mapping

This is the list of registry entities that represent the artifact in registries. On the right are the
following buttons:

= Add adds aregistry mapping, as described in "Mapping an Artifact Type to a Registry " on
page 33.

= Edit edits the mapping, as described in "Mapping an Artifact Type to a Registry " on page 33.
= Remove removes the mapping from the artifact.

The following registry mapping parameters are displayed in this pane:

Parameter Definition
Registry Name = The registry that the artifact type is mapped to.

TModel Key The taxonomy key used to categorize the UDDI entity in the registry.

Key Name The name used to categorize the UDDI entity in the registry.
Key Value The value used to categorize the UDDI entity in the registry.
Extension Which extension this mapping is part of.

o Property Mappings
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This is the list of the properties of the artifact and if they are mapped to a registry. On the right
are the following buttons:

= Add adds a new registry mapping for the selected property, as described in "Mapping an
Artifact Type to a Registry " on page 33.

= Edit edits a property mapping, as described in "Mapping an Artifact Type to a Registry " on
page 33.

= Remove removes a mapping from the selected property.

The following registry mapping parameters are displayed in this pane:

Parameter Definition

Property Name | The name of the property.

Registry Name | The registry that the artifact type property is mapped to.

TModel Key The taxonomy key used to categorize the UDDI entity in the registry.
Key Name The name used to categorize the UDDI entity in the registry.

Extension Which extension this property is part of.

Messages View

The Messages view tracks the changes that you make to extension entities and displays any
warnings and problems that may occur as a result of those actions:

Messages View

IR X370

Ackion Cause
= [ Delete Property [Tue May 01 12:52:59 CEST 2007]

Property 'Definition of' cannaok be removed because it is used in artifact "WSDOL', B Artifack Tvpe "WwshL'
@ Itis not allowed to remove property 'Definition of' as inverse property 'Definition’ is contained in artifac [ Artifact Package ‘artifact’
@ It is not allowed to remove property 'Definition of' as inverse property 'Definition’ is contained in artifac [& Artifact Type 'SOAP Service'
@ Itis not allowed to remove property 'Definition of' as inverse property 'Definition’ is contained in artifac & Artifack Type 'HTTP Service'
[7] Delete Property [Tue May 01 12:52:55 CEST 2007]
|| Save Artifack Type [Tue May 01 12:52:43 CEST 2007] [E Artifack Tvpe '‘Business Services'

Double-clicking an item in the tree opens the relevant editor for that object.

project.xml Editor

The project editor allows you to configure your extension project. It contains three tabs described in
the following sections:
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o "Project Editor: Overview Tab " below
¢ "Project Editor: Environment Tab " on the facing page

+ "Project Editor: Dependencies Tab " on page 60

Project Editor: Overview Tab

The Overview tab enables you to view and amend the basic parameters of your extension project:

Project Editor: Overview Tab

B project.xml X =0

Overview

+ Project details

Project name:  com.systinet.soa.ext.company

Project bype: Exkension projeckt

Project location: ChDocuments and Settingsiplattiworkspacelcom, systinet, soa, ext.company
Last modified:  Tue, 1 May 2007 11:18:31 AM

= Extension details

Marne: | COMpany |

Wersion: | 1.0 |

Descripkion: | Company Specific |

LRI corn.systinet.s0a.ext, company

Mamespace: | com.systinet, soa,exk, company |

CQverview | Environment | Dependencies

The Overview tab contains the following collapsible panes:

o Project details displays parameters for the extension project:

Parameter Definition

Project name The name of the extension project.

Project type The project is an extension project.

Project location = The workspace folder that contains the extension project.

Last modified The last time the project was changed.

o Extension details enables you to configure some of the extension project parameters:
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Parameter Definition

Name The display name of the extension.

Version The version number of the extension project.

Description | A description of the extension project.

URI The identifier for the extension in the configuration (not editable).

Namespace | The prefix used for the URI when you create a new artifact type or property.

Project Editor: Environment Tab

The Environment tab displays the parameters of the HP Systinet server that the Customization
Editor is configured for:

Project Editor: Environment Tab

B projectxml X =0

Platform Environment

« Platform environment

Flatform Home: C \Hewlett-Pack ardhSystinetiFlatform
Extension folder; C Hewlett-PackardhSystinetFlatformiextensions
Sarver LRL; http: flocahost 8080503

Develop JSPs:

JBoss Deploy Directory: C4JBoss Platform\server\defaultydeploy
JBoss INDI Fort: 1033

Owverview |Ervironment | Dependencies

The Environment tab contains the following parameters:

Parameter Definition
Platform Home Your HP Systinet installation folder.
Extension Folder The location of the extension folder in your HP Systinet installation.
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Parameter Definition

Server URL The URL used to access HP Systinet.

Deploy JSPs Indicates if component and JSP development is configured for your
extension project.

JBoss Deploy Deployment directory for your JBoss application server.

Directory

JBoss JNDI Port JNDI port configured in your JBoss application server.

Project Editor: Dependencies Tab

The Dependencies tab displays general information about your extension project and any
dependencies that is has:

Project Editor:Dependencies Tab

E project.xml X =0
Dependencies ]
Extension dependencies Project and extension general information
Hierarchical view of required extensions: Properties of the selected extension

company (v1.0) Mame: company

Wersion: 1.0

Description: Company Specific

LIRI: com.systinet, soa.ext.company
Buildtime:  Fri Apr 27 15:45:00 CEST 2007

Owerviews | Environment | Dependencies

The Dependencies tab contains the following panes:

« Extension dependencies displays a tree of extensions that the extension project is dependent
on.

o Project and extension general information displays parameters of the extension project:

Parameter Definition

Name The name of the extension.

Version The version number of the extension project.

Description = A description of the extension project.

URI The identifier for the extension project in the configuration (not editable).

Buildtime The creation date and time of the extension.
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Property Editor

Properties are attributes of artifacts. The property editor allows you to modify the properties in your

extension project. Each property has an editor with the property name as the title containing the
tabs described in the following sections:

o "Property Editor: Overview Tab " below
The main attributes of the property.
o "Property Editor: Advanced Tab " on the next page

The advanced attributes of the property.

Property Editor: Overview Tab

The Overview tab displays the general attributes of the artifact and enables you to modify some of
them:

Description Editor: Overview Tab

[ Description &3

Overview

General Information

Dizplay Mame: | Description

Local Mame:

|
| description

URI: urn:com:systinet:soa:model:properties:description

Description of the artifact, what it is used for etc,
Description:

Collection Display Mame: | Description

Deprecated:

Property Type

Property Type: textareaPropertyType

Overview | Advanced

This tab contains the following panes:

o General

The following property parameters are displayed in this segment:
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Parameter Definition

Display Name The name of the property as it appears in the HP Systinet Ul.

Local Name The name of the property as it is stored in the extension.

URI The identifier for the property descriptor in the configuration.

Description The description of the property as it appears in the HP Systinet Ul.

Collection Display The plural version of the name as it appears in the HP Systinet Ul.

Name

Deprecated A check box indicating whether the property is currently active in the
extension.

o Property Type, Relationship, or Taxonomy
There are three types of property and this segment is specific to each:
= Property Type
The property type for primitive properties.
= Relationship

This pane displays the source and target artifacts that this relationship links and some
parameters of the inverse relationship. On the right are two sets of two buttons for altering the
source and target artifacts:

o Add selects an artifact in the extension to source or target.
o Remove removes the relationship from a source or target artifact.
= Taxonomy

The taxonomy that contains the available options for this property with Browse to select a
new taxonomy from the extension project.

Property Editor: Advanced Tab

The Advanced tab displays the advanced attributes of the property and allows you to modify them:

Description Editor: Advanced Tab
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[ Description 7

w Multiple Cardinality

An artifact can have | 1] | and | unbounded | this property.

~ Default Values

Default Value:

Multiple Default Value:

~ Database Sizes

MName | Size | Extension

Overview | Advanced

This tab contains the following panes:

Multiple Cardinality:

Parameter Definition

MinOccurs  If a property has multiple cardinality this parameter is the minimum occurrences of
the property in an artifact.

MaxOccurs | If a property has multiple cardinality this parameter is the maximum occurrences of
the property in an artifact. Use unbounded if there is no limit.

Caution: Properties that inherit urn:com:systinet:soa:model:propertyTypes:text, such as
Name, cannot have multiple instances. If you need a text property with multiple cardinality, use one
that inherits urn:com: systinet:soa:model:propertyTypes:plainText.

Note: Cardinality for incoming relationship properties cannot be changed.

e Default Values:

Parameter Definition

Default Value An XML extract defining the default value.

Multiple Default An XML extract defining default values in the case of multiple
Value cardinality.

o Database Sizes
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Displays optional database sizing for property elements with Add, Edit, and Remove
functionality.

Property Group Editor

Properties can be organized into groups. The property group editor allows you to add and remove
properties from a property group. Each property group has an editor with the property group name as
the title:

System Properties Editor

E System Properties X =0
”~
- General 1
Display Name: 'p'ystem Properties
LIRI: urn:com: syskinet: soa:model: propertyGroups  systemProperties
~ Properties
Mame Cardinality = Extension Mew ...
5 mame mulkiple company
[5 Description mulkiple company
5 Revision optional company
[ Last Revision optional Company
[5 artifact Type mulkiple company
[ Other Relationship multiple company
[ 1ncoming Relationship - multiple company
5 Cakeqgories optional Company B
[ 1dentifier Bag opkional company
w

The editor contains the following collapsible segments:
o General enables you to change the Display Name and view the URI of the property group.
o Properties enables you to manage the property group.

On the right are three buttons:

= New creates a new property, as described in "Creating a Property Group " on page 38.

= Add adds a property to the group from the list of available properties.

= Remove removes the selected property from this property group.

The following property parameters are displayed and described in the table below:
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Parameter Definition
Name The name of the property.

Cardinality = The occurrence of the property in an artifact with options:
= Optional

The property is not required to be populated.
= Required

The property must be populated.
= Multiple

The property can occur multiple times with different
values.

Extension = Which extension this property is part of.

Search View

The Search view displays the results of a search or find usage query:

Search View

O G X% @B Y e F-#T =0

Search results for ‘contract’ {30 matches)
= @ Artifact Tvpes

[E Contract
[} Request
[E Usage Flan
@ Property Descripkors
= [E Property Groups
[& Contract Consumer Properties
B contract Properties

The results are shown as a tree of artifact types, properties, and property groups containing the
requested item.

Double-click an artifact type, property, or group to open the relevant editor.

Tasks Editor

Tasks are top level HP Systinet Ul components accessible via their URIs. The tasks editor allows
you to create, edit, and remove tasks from your extension project.

Tasks Editor
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sk =

Tasks
Tasks

Lri Component Caption | Extension Mew ...
= {fwidgetsibinary-datajeditarattachmentUplaad  fwidgets/binary-dataeditor AttachmentUpload kesk i
& jwidgets/binary-data/editor Jwidgets/binary-data/editor kesk

& jwebService verificationverificationResult fwebServiceverificationverificationResult kesk

& jwebService/operationDetail fwebService/operationDetail kesk

B jviewacl aclviewCompanent kest

B jutilfnoPermission JutilfnoPermissian kest

B juserstorefuser-preferences Juserstorefuser-preferences kest

B juserstore/server-preferences Juserstorefserver-preferences kest

& jundeleteConfirmation undeleteConfirmation best

& jtools/collectionUpdatewizard [JroolsfcollectionUpdateviizard best

B jtest/testUri teskComponent testTask  tesk

& {ssojits ssolnkersiteTransferaervice best

B jsmywsdlUploadwwizard fsmwsdUploadwizard fest

& jsmfupdateDocumentation JsmfupdateDocumentation fest

B fsmjrepublishiizard fsm/republishiwizard fest

B fsmjonedction [smjoneaction fest

B fsminoPermissionsC [smfnoPermission3C fest

B fsmflistRejectedRequestsofaservice JfomsimpleList fest

B fsmflistRecentUpdates JfomsimpleList fest

B fsmflistPendingRequestsOfaservice JfomsimpleList fest

B fsmflistMyServices JfomsimpleList fest

p P A 2

On the right are the following buttons:
o New opens the New Task dialog box, as described in "Creating a Task " on page 41.

o Edit opens the Edit Task dialog box with the same parameters described in "Creating a Task "
on page 41.

o Remove deletes the selected task from your extension project.
The following parameters relate to tasks:

Parameter Definition

URI The identifier for the task.

Component  The component the task uses.

Caption A name for the task.

Extension = Which extension this task is part of.
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Taxonomies Editor

Taxonomies are category groups that allow you to organize your services. The taxonomies editor
allows the import and removal of taxonomies from your extension project:

Taxonomies Editor

Taxonomies

Taxenomies

Name THodel Key Extension
demo:deparkrentID uddi: systinet.comn:demao:deparkrentid company
demo:hierarchy uddi: systinet,com;demo:hierarchy COmnpany Update
demo:lacation: floor uddi: systinet.com: demo:lacation: floor compansy

dnb-com:D-U-M-5 uddi:uddi.org:ubr:identifier :dnb.com: d-u-n-s COMmpany

COmparty

ebxml-org:specifications uddi: ebxml. org:specificati

54~

ons

COompany'

n 1199 ud

H suddi,org;ubr:categorization: H COMnpany
ntis-gov:naics: 2002 uddi:uddi.org:ubr:categaorization: naics: 2002 compansy
ntis-gov:sic: 1997 uddi: 70a380F61-77bc-4521-a5e2-2 540650 c35dd company
systinet-com: acl uddi: syskinet.com:acl Company
systinet-cam: acl:create-allowed uddi:systinet.com: acl: create-allowed company
systinet-cam: acl:create-denied uddi: systinet.com; acl: create-denied company
systinet-cam: acl:delete-allowed uddi: systinet.com: acl: delete-allowed compansy
systinet-com: acl:delete-denied uddi:systinet.com: acl: delete-denied company
systinet-com: acl:find-allowed uddi: systinet.com: acl:find-allawed company
systinet-com: acl:find-denied uddi: systinet.com: acl:find-denied company

| £

On the right are the following buttons:
o Importimports taxonomies from the active HP Systinet server.
The referenced HP Systinet server must be running during import.

o Update refreshes the taxonomy list with any changes from the HP Systinet server.
o Remove deletes the selected taxonomy from the extension project.
The following parameters relate to taxonomies:

Parameter Definition

Name The name of the taxonomy as it is stored in the extension.

TModel Key = The taxonomy key identifier.

Extension  Which extension this taxonomy is part of.
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Dialog Boxes

Each Customization Editor input dialog is described in the following sections:

"New Artifact " below: Create a new artifact type or package.
"New Component " on page 70: Create a new component.

"New Extension Project " on page 71: Create an extension project.
"New Property " on page 76: Create a new property.

"New Property Group " on page 80: Create a new property group.
"New Task " on page 81: Create a new task.

"Registry Mapping " on page 82: Add registry mapping.

"Search " on page 84: Search your extension project.

New Artifact

The New Artifact Type and New Artifact Package dialogs are identical and consist of the following
ordered stages:

1.

2.

"New Artifact: Create " below

"New Artifact: Database Settings " on page 70

New Artifact: Create

Enter general parameters of the new artifact type:
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¥ New Artifact Type

Hew Artifact Type
Create a new artifact type /

wayhill

Display name

LRI | urn:com:mike-ce:artifacts:c_wavybill Artifact

waybills

|
Local Mame | c_wavybilArtifact |
|
Collection Display Mame |

Package | s0a L]
Extends | | B

Description wayhil

Data attachment ||‘|D|‘|E w |
Revision Less

':?:' < Back Mext = ] [ Finish l [ Cancel

Parameter Definition

Display The name of the artifact as it appears in the HP Systinet Ul.
Name

Local Name @ The name of the artifact as it is stored in the extension.

URI The identifier of the artifact descriptor in the configuration.

Collection The plural name of the artifact as it appears in the HP Systinet Ul.

Display

Name

Package Click Browse to select a parent artifact package to which the artifact belongs.
The default is SOA if the new artifact is not created from within an existing artifact
package.

Extends If you select Extends, the new artifact inherits any future changes made to the

chosen parent artifact.

Click Browse to select an artifact type to inherit the properties from
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Parameter Definition
Description | The description of the artifact type as it appears in the HP Systinet Ul.

Data If the artifact type normally has attached data content, select the content type
Attachment = from the drop-down list.

Revisionless = Specify the artifact to be revisionless. These type of artifacts update without
creating a new revision.

New Artifact: Database Settings

Specify database settings for the new artifact type:

€3 New Artifact Type |:|®

Database Settings

Specfy artifact type database settings. /

Collection name | wavhillartifacts |

Database table name | ga_wavhilartifacts |

':':’:' Finish ] [ Cancel

Parameter Definition
Collection name The name of collection where the artifact instances are stored

Database table name = The name of the database table where instances of this artifact are
stored

You cannot change these parameters if the new artifact extends an artifact type that already
defines them.

New Component

Enter general parameters for the new component:
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Mew Component

Creake a new companent

31 New Component @

Marme: | testComponent |
Page: | [testikest Companent, jsp |
Class name: | test.TestCnmpunend |
Mame Walue
[ada... ]
Camponent parameters: m
Remoye
':':’:' Einish l [ Cancel
Parameter Definition
Name The name of the component as it is stored in the extension.
Page The JSP used by the component.
Class name The Java class used by the component.
Component Use Add and Remove to select parameters to use with the
parameters component.

New Extension Project

The New Extension Project dialog consists of the following stages depending on the options you

select:

1. "New Extension Project: Specify HP Systinet Server Installation " on the facing page

2. "New Extension Project: New Server" on page 73

3. "New Project: Select Working Extensions " on page 74
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4. "New Project: Create a New Extension " on page 75

5. "New Project: Create Dependencies " on page 76

New Extension Project: Specify HP Systinet Server
Installation

Specify configuration details for an HP Systinet server:

[ New Extension Project Elle

Specify HP S0A Systinet Server Installation

Specify HP 304 Systinet server installation providing the core

configuration and existing extensions,

Platform Home: | Ci\Hewlett-Packard \Systinet | [Bru:uwse... ]
Extension folder: | C\Hewlett-Packard \Systinet\extensions | [Bru:uwse... ]

Production Mode:

Praoject type: b
Advanced Options
JBoss Deploy Directory: | :\JBoss Platform'zerver default'deploy | [Bru:uwse... ]
JBoss JNDI Port: | 1099 |
Parameter Definition
Platform Use Browse to select the HP Systinet platform installation folder
Home
Extension = Use Browse to select the extension folder in your HP Systinet installation
Folder (populated by default based on the Platform Home input
Production = Select this check-box to create the project in production mode (selected by default).
Mode This disables customizations that would require the deletion of server data during

the application of the extension to HP Systinet.
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Parameter Definition
Project Select from the following options:
Type
o model for changes to the SDM model.

e code for custom code components and Ul customizations.

¢ mixed for both types of changes (not recommended).

JBoss Use Browse to select the deployment directory for your application server (usually
Deploy JBOSS_HOME\server\default\deploy)

Directory

JBoss Input the JNDI Port for your application server.

JNDI Port

Only JBoss is supported for the development of components and tasks in this release.

New Extension Project: New Server

Specify parameters for the new server:

3 New Extension Project |:I|E|E|

Hew Server

Add new HP SOA Systinet server /

General

Mame: | HP S0A Systinet server on localhost |

JRL: | http: /localhost: 3080 /s0a |

Credentials

sername: | admin |

Passwaord: | LTy |

“saves
[ validate connection

':':’:' [ « Back ” Mext = FEinish

Parameter Definition

Name The name you want to use for the new server.
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Parameter Definition
URL The endpoint URL of the server you want to use.

Username and | Your login credentials for the specified server.
Password

Save password = Select this check-box to store your login credentials.

Validate Select this check-box to validate connection to the server. Otherwise, you can
connection validate connection the next time you log in.

New Project: Select Working Extensions

Choose how to create your working extensions:

£ New Extension Project

Select Working Extensions

Create a new HP SOA Systinet Extension. It may be created from
scratch or based on an existing extension,

(%) Create new extension project from scratch
() Edit an existing extension
O Create a new extension from existing one

Available Extensions

{9 core (v3.0)

m

@ [ < Back ]L Mext > ] Finish

Selection Action

Create a new extension from Click Next.
scratch
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Selection Action

Edit an existing extension Do one of the following:
o Select from the available extensions and click Next.

o Click Add extension to browse for and select a different
extension, and click Next.

You cannot edit the core extension

Create a new extension froman | Do one of the following:
existing one
e Select from the available extensions and click Next.
You cannot use the core extensions.

o Click Add extension to browse for and select a different
extension, and click Next.

New Project: Create a New Extension

Enter general parameters for the new extension:

8 New Extension Project |:||E|E|

Create project from existing extension [
Set properties for exension poject /

MName: | ourmodel

MNamespace: | urn:com:ourmode!

Version: | 1.0

|
|
Description: | Customer Specific Model |
|
|

URI: | com.systinet.soa,ext, cust.ourmodel|

o (o] oo

Parameter Definition
Name The name of your extension project
Namespace The prefix used for the URI when creating a new artifact type or property

Description = A description of your extension project
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Parameter Definition
Version The extension version number

URI The unique identifier of the extension

New Project: Create Dependencies

Select extensions to declare dependencies:

[ New Extension Project E'E'

Add Dependencies

If vou know about extensions that provide customization you want to
re-use, you may declare a dependency on such extension, You may select
from extensions detected in your server installation or add a new

Available Extensions
=] M core (v3.0)

test (v1.0)
OO0 test (v1.0) Add extension. ..

Depends on;

@ < Back ” Mext = Finish

Your changes are stored in your extension. You can change the labels and descriptions of elements
from dependent extensions but you cannot delete them or make any other changes. If you want to
delete an element from a dependent extension, you must deprecate it.

New Property
The New Property dialog contains parameters according to the property type:
¢ "New Property: Primitive " on the next page
o "New Property: Relationship " on the next page
o "New Property: Taxonomy " on page 79

For details about property types, see "Properties " on page 20.
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New Property: Primitive

Enter general parameters for the new primitive property:

[5 New Property @

Display Mame:
Local Mame:

RI:

Mew primitive property

Create a new primitive properky /

Collection Display Mame:; | destinations

| destination

| destination

| urm:com:kest:properties: destination

Description: destination
Property Twpe: plainTextProperty Tyvpe | |§Brn:nwse...
':':’:' Mexk = ] [ Einish ] [ Cancel
Parameter Definition
Display Name = The name of the property as it appears in the HP Systinet Ul
Local Name The name of the property as it is stored in the extension
URI The identifier for property in the configuration
Collection The plural name of the property as it appears in the HP Systinet Ul
Display Name
Description The description of the property as it appears in the HP Systinet Ul
Property Type Use Browse to select a property from the available primitive property types.

For details, see "Properties " on page 20.

New Property: Relationship

Enter general parameters for the new relationship property:
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New relationship property

Create new relationship property /

Display Mame: | distance |
Local Mame: | c_distance |
LRI: | urn:com:mike-ce:properties:c_distance |
Caollection Display Mame: | distances |
Description: distance

Relation type: |urn:com:systinet:sc-a:m-:-del:propertyT\,fpes:du:-cumentReIatiu:-nship A |
From Entity: | Contact | lBrowse... ]
To Entity: | Organizational Unit | [Browse... ]

Inverse Display Mame:

| return distance |

Inverse Local Mame: | c_returnDistance |

Inverse URI: | urn:com:mike-ce:properties:c_returnDistance |

Inverse Collection Display Mame: | return distances |

Inverse Relationship Description: | return distance

@ Finish ] [ Cancel
Parameter Definition
Display Name The name of the property as it appears in the HP Systinet Ul
Local Name The name of the property as it is stored in the extension
URI The identifier for the property in the configuration

Collection Display Name = The plural name of the property as it appears in the HP Systinet Ul

Description The description of the property as it appears in the HP Systinet Ul
Relation Type Select a type from the drop-down list
From Entity Use Browse to select the source artifact type or property group of

the relationship
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Parameter Definition

To Entity Use Browse to select the target artifact type or property group of the
relationship

Inverse Display Name The name of the inverse relationship property as it appears in the HP
Systinet Ul

Inverse Local Name The name of the inverse relationship property as it is stored in the
extension

Inverse URI The identifier for the inverse property descriptor in the configuration

Inverse Collection The plural name of the inverse relationship property as it appears in

Display Name the HP Systinet Ul

Inverse Relationship The description of the inverse relationship property as it appears in

Description the HP Systinet Ul

New Property: Taxonomy

Enter general parameters for the new taxonomy property:

3 New Property

New taxonomy property

) Please enter non-empty property /
URI

Display Name:

Local Mame:

URI:

Collection Display Mame:

Description:

Taxonomy name: | [Eirnwse... ] [Create]

Taxonomy key:
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Parameter Definition

Display The name of the property as it appears in the HP Systinet Ul
Name

Local Name = The name of the property as it is stored in the extension

URI The identifier for the property in the configuration

Collection The plural name of the property as it appears in the HP Systinet Ul
Display

Name

Description = The description of the property as it appears in the HP Systinet Ul

Taxonomy = Use Browse to select a taxonomy from the available taxonomies with an option to
import taxonomies available in HP Systinet that are not in your extension.

New Property Group

Enter general parameters for the new property group:

(%1 New Property Group

Mew Property Group

Creake a new property group /

Display name | Contack Details |

LRI | com.systinet, s0a.exk. company;properbyGroups: conkactDetails |
Properties
Mame Cardinality  Extension
Mame  required company
Email  multiple company
Remoye
@ Finish ] [ Cancel
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Parameter Definition

Display Name = The name of the property group as it appears in the HP Systinet Ul

URI The identifier for the property group descriptor in the configuration
Properties Use Add and Remove to select the properties in the group
New Task

Enter general parameters for the new task:

D New Task §| le
Hew Task ———
@ Enter task component /
URI: | ftest/testUri |
Component: | | | Browse |
Caption: | testTask| |
Name | Value
Task parameters: Remave

Py
(2] Finish Cancel

Parameter Definition

Uri The identifier for the task

Component Use Browse to select the component to associate with the task
Caption A visible name for the task.

Task parameters Use Add and Remove to select parameters to use with the task

Page 81 of 87 HP Systinet Workbench (10.00)



Customization Editor User Guide
Appendix A: Dialog Boxes

New Taxonomy

Enter general parameters for the new taxonomy:

[ New Taxonomy

Taxonomy

Create a new taxonomy W

Taxonomy name: | |

Taxonormy ID: | |

Filename: | |

Source ﬁalder:| Browse

o -
(2 Finish Cancel

Parameter Definition
Taxonomy Name = The name of the new taxonomy as it will appear in the Systinet Ul.
Taxonomy ID The system identifier of the new taxonomy.

Filename The name of the taxonomy as it appears in the repository.

Registry Mapping
¢ "Registry Mapping: New Artifact Mapping " below

¢ "Registry Mapping: New Property Mapping " on the next page

Registry Mapping: New Artifact Mapping

Enter parameters for the new registry mapping of the artifact:
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¥ Registry Mapping @

New Artifact Mapping
Add a new reqistry mapping Faor artifact
Reqgiskry | all others | [ Select l
T-Modelkey | uddissyskinet, com;acl | [ Add ... l
T-Modelkey version 2 | |
Key Mame | Business Entity |
Key YWalue | |
Advanced options
Display name |
Cache content [ ]
Direction |Both w |
@ l l Cancel
Parameter Definition
Registry Use Select to select from the available registries
T-ModelKey Use Add to select from the available taxonomies or input one
T-ModelKey If you are mapping to a UDDI version 2 registry input a taxonomy key
version 2
Key Name The name used to categorize the UDDI entity in the registry
Key Value The value used to categorize the tModel in the registry

Display Name The name of the mapping as it appears in the HP Systinet Ul

Cache content If selected, the content of documents referenced from the UDDI entity are

cached in HP Systinet

Direction Select the direction of the mapping from the drop-down list

Registry Mapping: New Property Mapping

Enter parameters for the new registry mapping of the property:
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New Property Mapping

Add a new registry mapping for property
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Properky | Drescription | ’ Select ]

Direction | Bokh R |

Reqiskry | = | [ Select ]

T-Modelkey |uddi:systinet.com:demo:departmentid | [ add ... ]

T-Modelkey version 2 | |

Key Marme | |

"':’:' ] [ Cancel
Parameter Definition
Property Use Select to select from the available properties
Direction Select the direction of the mapping from the drop-down list
Registry Use Select to select from the available registries
T-ModelKey Use Add to select from the available taxonomies or input one

T-ModelKey version 2

Key Name

Search

Enter parameters to search your extension project:

The name used to categorize the UDDI entity in the registry

HP Systinet Workbench (10.00)

If you are mapping to a UDDI version 2 registry input a taxonomy key
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A Search B]

] SDM search

2

E? File Search | %7 Java Search

Containig text:

v | [ case sensitive

(* = any string, ? = any character, Y, = escape for literals: * 2 ) [] Regular expression

Search For Search In
Artifact Type Display name
Property Local Mame
Property groLp Description
Scope

Extersion: (@) Al Extensions () Active Extersion

Project:

@ Search H Cancel

Parameter Definition

Containing = The parameter to search for

text

Case Check the box to make the search case sensitive

sensitive

Regular Enables more sophisticated search parameters (for example, to find everything with

expression = more than one word). This is an advanced topic beyond the scope of this guide.

Search For Select the SDM entities to search
SearchIn | Select the entity attributes to search

Scope Select the extension to search

Share Project

Define parameters for the CVS repository:

Page 85 of 87 HP Systinet Workbench (10.00)



Customization Editor User Guide
Appendix A: Dialog Boxes

A Share Project

Enter Repository Location Information
Define the location and protocol required to connect with an existing CVS repository. %

Location

Host: | | w |
Repository path: | v|
Authentication

User: | v|
Password: | |
Connection

Connection type: ||:|server v|

{*) Use default port
{:) Use port: |

[]save password

15, Saved passwords are stored on your computer in a file that is difficult, but not impossible,
for an intruder to read.

Configure connection preferences. ..

i . -
(2 < Back it = nish Cancel

-3
m
o]
o
T

Parameter Definition
Host The name of the host server.
Repository path The location of the host server.

Userand Password = Your login credentials for the host server.

Connection type The communication protocol for the CVS host server.
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Localname Naming Rules

The naming strategy used to generate the names of database tables and columns can only process
a specific subset of XML identifiers (element and attribute names). This is because the existing
database engines have limits for the length of tablename/columnname identifiers. XML identifiers
are generated from the SDM configuration in a straightforward way. This section omits the XML
layer for simplicity and summarizes the rules at the SDM level which is more user-friendly.

When creating an artifact type or property, for the localname, do the following:
e Use Latin characters where possible (A-Z, a-z)

o Use short identifiers where possible to improve the readabililty of the DB schema. For example,
stSchtronXslt is a better localname than searchAndTransformSchematronXsltUrlLink.

e You can safely use underscores in localnames.
Do not use numbers in localnames where possible. They should not be used in artifact
localnames at all and to avoid confusion, do not use numbers in property localnames when the
property is in multiple cardinality.

Using numbers in localnames increases the chances that extension application fails.

There are no restrictions on property group localnames as they are not represented in the
database schema.

It is difficult to generate separate validation rules for properties and artifacts because the
generated DB identifiers are often influenced by a combination of both.
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